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Small DocumentsWhat’s It For

Introduction to Structural Systems - TM320 Summer 2012 
Instructor Lorem Q. Ipsum Boston Architectural College

Final

Name:                                                             

Show all your work. Justify your work. Keep track of units. You should work on different paper than the 
exam handout.

1. 

A roof is being built over an ice skating rink. The roof is supported on a series of 
arches. The span of each arch is 100’. The length of the structure is 200’. There are 
nine arches spaced evenly at 25’.

 The   system weighs 12 psf (pounds per square foot); snow weighs 35 psf; 
the arches are made of concrete that weighs 160 plf (pounds per linear foot).

 The arch must be 35’ tall at the center.

 a)  What is the shape of the (typical) arch that  the load and geometry 
requirements?

 b)  What is the magnitude of the reactions supporting the arch?

Document Creation
InDesign is a computer program for creating documents of most 
any size and purpose.

InDesign has a varied toolset consisting of:

•	 tools similar to Illustrator’s for creating art,
•	 tools for creating text
•	 tools for arranging and manipulating art and text together 

on a page
•	 tools for managing a number of pages in a single document
•	 tools for managing a number of documents as a single book

So when should you use InDesign?

•	 text documents
•	 mixed content documents
•	 multi-page documents
•	 multi-platfor documents (web, phone, PDF, print)

It might be better to ask when shouldn’t you use InDesign?

•	 when you are creating a single piece of artwork, such as a 
rendering or business card

•	 when you are creating a drawing set from CAD

Even in those circumstances, you might want to use InDesing as a 
way to create a reusable document format.

Word to the Wise
While InDesign does have vector artwork tools, they are a small 
subset of those available in Illustrator. It is best to use them for 
basic document support graphics.

Another Word
InDesign has superior page layout and typesetting ability. There is 
no reason not to pick it up for your regular word processing needs. 
Yes, it even has spell checking. It’s up there on the edit menu. It 
even does the wiggly red lyne thing.
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What’s It For Whole Posters

Not Just For Magazines
Don’t get hung up on the idea that a document is something you 
can stick in the back pocket of a notebook. You can (and should) 
make your presentation boards with InDesign, you can make busi-
ness cards, you can (and should) make your thesis...

Overlap
Yes, there is overlap with other Adobe products. But the primary 
strengths are still:

•	 Photoshop - photographic image manipulation
•	 Illustrator - clean outline based artwork
•	 InDesign - type and document creation

 Experience and an awareness of when something is getting too 
annoying are what tell you which program to use.
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6

Traces - Parking

As noted earlier, signs on the existing building and 
in the adjacent Walgreens lot indicate that parking 
is a major concern in the area.
There is an issue of note though. In the Walgreens 
parking lot fifty-six (56) cars were counted in spaces 
accompanied by signs indicating that these spaces 
were for the exclusive use of people in the Wal-
greens store. A count in the store revealed only fif-
teen (15) people including one married couple and 
one family of four (4). A full count of the Walgreens 
back spaces could not be undertaken but enough 
staff were observed in the retail space that it is not 
expected that the missing people would be found 
inside Walgreens.

5

Vegetation

THIS SITE

250’

Grass

Tree

-

planted against the front of the existing building. 

couple of ragged trees.

side to the rear of the existing building are paved 

site is a narrow paved passage between the exist-
ing building and the neighboring telephone switch 
building.
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500’

This
Site

The site lies within the central business district of 
Needham. Most of the area retail is within a five 
minute walk of the site. Downtown extends further 
north and south along Highland Ave. Most of this 
further retail is within a ten minute walk of the site.
Outside the business zones along Highland Ave. 
and Great Plain Ave. are neighborhoods of single 
family housing on lots of approximately quarter to 
half an acre. The town high school lies just outside 
the ten minute radius to the north east. A number 
of churches are within a five minute walk. A major 
area hospital lies within a ten minute walk to the 
south east.

3

Lynch Analysis

The site at 56 Pickering Street is on the edge of the 
densest portion of Needham’s downtown commer-
cial district. Pickering St. is a quiet side street with 
mostly single family residential.
The downtown district is long and narrow, served 
primarily by Chestnut Street and Highland Avenue 
running north/south. Great Plain Avenue connects 
Needham to neighboring towns east/west.
MBTA commuter rail stops two and a half blocks 
west of the site behind Chapel Street and bus ser-
vice runs a block west on Highland Ave.
One hundred yards north of the site, at the corner of 
Pickering St. and May St. are a multi-family senior 
housing facility and private school.
To the south of the Downtown district lies Glover 
Memorial Hospital.
Across Pickering Street from the site is a playfield 
and playground used by nearby intown residents.

Path

Node
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Edge
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High School

Center East

City Hall

Glover
Memorial
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Dedham St.

Greene’s
Playground

Train Station

Needham 
High School

500’

This
Site

Program:

New Fire Station
56 Pickering Street
Needham, MA  02492

Peter M. Gruhn
Programming and Codes

Wednesday 4:00 pm
Fall 2009

Page After Page
InDesign really starts to shine when you need to manage a great 
number of pages. A document can be... I don’t know... lots of pages 
long and InDesign can help you with repeated elements, consis-
tency of appearance, organization, page numbering.

Vocabulary Warning
InDesign has a special meaning for the word “Book” and it makes 
talking about books the things made out of paper and Books the 
things InDesign provides at the same time a little difficult. See 
page 14.
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... and WhyThree Most Important Things

Why InDesign
Used right, InDesign makes it easy to create a document that is

•	 Consistent - All the headlines are the right color; all the 
paragraphs use the same size of the same font; elements on 
different pages line up in uniform ways.
Instead of opening a document and start to type on page 57 
and wonder “wait, was I using 11 point Palatino or 12 point 
TNR in this document” [it’s 10 point Caslon] you just hit the 
“Plain Text” style and it comes out right. It’s all about making 
it easy, or in the words of Donald Norman, “putting informa-
tion in the world”1

•	 Modifiable - If a font is changed or a color tweaked, the 
whole document updates automatically and maintains the 
consistency you created initially.
Instead of thinking “I think this document would look better 
with 10 point Palatino instead of 11 point Palatino and hav-
ing to go back through every page and changing every bit of 
text, oops not that one, to the new size InDesign just takes 
care of it for you.

If  You Do it Right
In order to get these advantages you need to use these three things 
all the time from the beginning of a document:

•	 Master Pages - layout guides and repeated elements such as 
topic headers and page numbers.

•	 Paragraph Styles - font selection, alignment, spacing.
•	 Swatches - colors

1	 Norman, Donald. The Design of Everyday Things. New York: 
Basic Books, 2002.

!!!
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PraiseThree Most Important Things

It Can Do it
Professionals have been using InDesign for over ten years to get 
documents out the door against deadlines. The majority of printed 
material you see is probably assembled in InDesign. What this 
means for us isn’t “yay, it’s popular” but rather:

•	 Can Do - If there is something you want to do in InDesign, 
somebody else probably wanted to do it already and if enough 
of them wanted to, there’s probably a way.

•	 Easy - If you are doing something in InDesign and it seems 
like the long/hard/tedious way, there’s probably a quick way 
to do it.

In either case, Google for an answer if you can’t figure it out by 
yourself.

Rarely has InDesign let me down. Put some effort into it and you 
will be rewarded.

Robust
Every now and then InDesign crashes. Far less often than most 
design software and maybe just a hair more than Photoshop.

BUT I don’t think I have ever lost anything. Just start InDesign 
back up and continue working where you left off. Every time you 
do anything the changes must be saved to disk. In three places.

Of course, don’t put all your faith in InDesign. Save often. Incre-
ment file names. Make backups.
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Interface Elements Using

Menu

Control Bar

Ruler

Panel

Document

Tool Bar

Lots Stuff  to Click On
InDesign uses the standard Adobe Creative Suite interface with 
six main areas:

•	 Menu - Commands for managing and manipulating the 
document and its contents.

•	 Tool Bar - Easy buttons for object creation and manipulation
•	 Document - The workspace that shows your creation.
•	 Panels - Where most of the action is.
•	 Control Bar - Options and tools related to the current tool 

or selection.
•	 Ruler - helps with accurate object placement.

It’s All On The Window Menu
Most of the deeper commands and options reside on panels. Since 
panels can be closed and moved around, it can be easy to lose track 
of a handy command. When you lose something, look for its panel 
on the Window menu. Everything is there and it’s probably where 
the thing you want is.

Rearrange
The panels system is very flexible. 

Panels can be rolled up by clicking on the blank gray area next to 
the individual panel names. 

Whole panel panes can be collapsed by clicking the tiny double 
arrow icon on the dark bar at the upper right. For me they always 
collapse down to icon and text, unlike Illustrator which does icons 
only. As a result the space savings isn’t worth my in my opinion. 
Myabe it can be done better. 

Panels can reordered, torn off and redocked by grabbing their tabs. 
As you move them around, watch for the blue highlighting in the 
UI to show you how they are going to arrange.
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What’s Best
How to arrange the interface is a matter of general efficiency com-
bined in large part with personal preference and a dose of current 
task.

InDesign provides Workspaces to save different interface con-
figurations. You can access them on the Window menu or use the 
dropdown in the upper right. You can see here that I have made my 
own workspace to remember the panels just the way I like them.

No Really, What’s Best?
Recommended panels to start with:

•	 Align
•	 Pages
•	 Stroke
•	 Swatches
•	 Paragraph Styles

You’ll soon find others that you want to keep around. Later when 
you find your stride, you will start organizing them into different 
task based Workspaces and you’ll really start to own the interface.

The Control Panel and Toolbar can be moved, floated, docked in 
strange places but so many programs are organized similarly that it 
probably is not worth breaking with tradition. On the other hand, 
maybe it’s nice to have all the things to click on clustered in one 
part of the screen.

Panels can also be moved to a different monitor if you have one 
available.
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Some Tiny DetailsUsing

New Button

Fly-out Menu
Fly-out Menu. Click and hold.

Ruler

Panel Menu Button

Fly-Out Menu
You’ll notice that some of the toolbar buttons have a little black 
triangle on them. This indicates that if you click and hold (or right 
click) on this button you will get a menu with other, related, but-
tons. For instance, the Rectangle button is part of the Shape group 
which also includes Ellipse and Polygon buttons.

Whichever button you last used in a group appears on the toolbar. 
This can get a little confusing. Sometimes you have to hunt “under” 
the buttons to find the tool you are looking for. With a little expe-
rience you learn which tools are grouped together.

New Button
Many panels contain lists of things you can create. At the bottom 
of each panel is a row of buttons. There’s a trash can for deleting 
items. Sometimes there’s a folder for grouping items. And more 
often than not, there’s a new button which may not be obvious 
to the new user. I think it looks like somebody peeling of the top 
sticky-note to get a brand new one.

Panel Menu
Every panel has its own associated menu in the upper right corner 
on the light gray next to the panel tabs. Lots of useful stuff hides 
here.

Ruler Units
By default the ruler is measured in sixths of an in (picas). You can  
change this. Either go to the menus, Edit: Preferences: Units & 
Increments where you can change the ruler units (but don’t change 
type units, you are already familiar with using points for that). Or 
you can right click on a ruler and change its units right there in 
the interface. You can do each ruler separately or right click at the 
corner where they meet to do both at the same time.
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Some More Tiny DetailsUsing

The None swatch. They may look the 
same...

But one is filled with None. 
The other with Paper.

Preview

Preview
Many of the dialogs in InDesign have a Preview checkbox. Turn 
it on. 

The Color of  No Color
Rather than have a separate settings for whether something should 
have a color and what that color is, InDesign just has a special color 
called None. It shows in Swatches as white with a red diagonal line. 
It doesn’t show in your artwork. There’s nothing there. Its name 
is always None. You can not change the name or the color. Why 
would you want to?



10Gateway Software Workshop
InDesign

 Navigation - Zoom and Pan Using

Pan - Spacebar

Zoom - Alt-Wheel, Ctrl-Equals ...

Moving About A Page
Navigation in InDesign is pretty easy. Since the page is two di-
mensional there are only pan and zoom controls to worry about. 
There are explicit tools for these functions but it is good to use the 
keyboard shortcuts. 

•	 Pan - hold down the spacebar to bring up the pan tool. Unless 
you are typing text, in which case holding down the spacebar 
makes a lot of spaces. 

•	 Zoom - the Z key gets the zoom tool. Ctrl-Equals and Ctrl-
Minus (I think of it as plus and minus, but the ‘+’ is actually 
shifted version of the ‘=’ key) will always zoom in out one step 
at a time.

•	 Fitting - Ctrl-Zero zooms so the current page fits in the win-
dow with very little white space around it. There are a number 
of other fitting options which you can browse on the View 
menu. In time you will decide how you like to work.

Even More
Note that double clicking on the Zoom and Pan buttons does 
something.

Note that double clicking on a page in the Pages panel moves to 
that page and double clicking a second time zooms to the whole 
page.

Up and Down
You can pan from one page to the next. You can use the scroll bars. 
You can use PageUp/PageDown. But the best way for browsing 
your document is Alt-PageUp / Alt-PageDown. This scrolls ex-
actly one page at a time and centers the page in the view. 
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Pages
Speaking of the Pages panel... This panel lists all of the pages in 
your document and is the easiest way to move about from page to 
page. The default is to show all spreads in a single vertical column. 
Change this by turning off Panel Menu: Panel Options: Pages: 
Show Vertically.

You might also want to change the size of the thumbnails while 
you are there.

Document Management
The pages panel is not just for navigation. Here you can add and 
delete pages; look on the panel menu or right click. You can also 
add pages by dragging Master Pages from the top part into the 
regular document part at the bottom. And there’s new and trash 
buttons at the bottom.

You can also move pages around the document by dragging them 
in the thumbnail view.
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How the Workspace LooksUsing

Clear Everything

ClearRegular

Display Performance

Fast Typical (Exaggerated) High Quality

Normal

Screen Mode

Preview

Display Options
There are a few display options that are good to use as you work 
with your document.

View: Screen Mode: 
There are four options but the ones you need are:

•	 Normal - shows the area around the page (the Pasteboard) 
and all the things there; it also shows margins and guides and 
the little page shadow.. all the stuff that helps you with laying 
things out but clutter up your vision.

•	 Preview - replaces the Pasteboard with gray, removes the page 
shadow and margins and guides and any non-printing mate-
rial. It makes your page look like it will actually look when 
finished. It is good to switch to Preview mode every now and 
then just to get a feel for how things look.

There is a hotkey that switches between the two modes.  
	 Just press W.

View: Display Performance
In order to stay responsive, InDesign typically displays a low 
resolution preview of graphics. This isn’t a problem, but it can be 
distracting, especially with vector art. There are three Display Per-
formance modes:

•	 Fast - Does not even display images, just a box with an X.
•	 Typical - The best balance between speed and visual quality.
•	 High Quality - Looks good but in a large file can slow things 

down. (It is the one I use most.)

Clear Everything Away
I don’t know what this is called. But if you hit the Tab key all 
the panels and menus are hidden. Combine it with W for a clean 
uncluttered preview of your document.
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New Document DialogDocument Creation

Let’s Make Something
InDesign’s starting dialog has an option to create a new document, 
or you can find it on the File menu. Typically what you want to 
create is a document. Even if what you are making is a multi-page 
bound book, you still want just a document.

What Values?!
The New Document dialog can be a little daunting at first, espe-
cially if you click the More Options button. Turns out it isn’t that 
bad.

•	 Document Preset - ignore this.
•	 Number of Pages - you can always add and delete pages so it 

mostly doesn’t matter. I like to start with maybe 5 or 8 pages. 
Just to feel a sense of accomplishment.

•	 Facing Pages - a left and right page joined at the middle with 
binding. Turn it off if you are going to print a stack of single 
sheets maybe with a staple in the corner or if you are going to 
make an on-screen presentation.

•	 Page Size - the physical size of the output medium. If you 
pick one of the presets, the Width and Height are filled in 
for you. In picas. But you can type in anything you want here: 
11in, 11”, 37cm... 

•	 Orientation - Portrait or Landscape. Depends on the docu-
ment you are making.

•	 Columns - Itnore it. Goes with Master Text Frame.
•	 Margins - How much white space there is around the edge 

of the page. Unless you can print “full bleed” your printer 
probably has a 1/4” or 1/8” margin where it will not print. 
InDesign’s default 1/2” margin is very safe but visually it is 
small. Ultimately Margins are just a special pink guide on the 
page. They do not physically limit you in any way.
Inside/Outside and Left/Right margins depend on the set-
ting of Facing Pages.

•	 More Options - you can ignore these.
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BooksDocument Sharing

Book vs. Book
There is a vocabulary problem. Most people think of a book as a 
single unified product, a document. A thesis is a document and a 
book. A Gateway project book is a document.

InDesign makes a distinction.

•	 Document - a single file with one or more pages.
•	 Book - a collection of Documents with coordinated styles 

and page numbers.

For a single author, a book might be used with each chapter in a 
separate document. But since formatting changes should be con-
sistent through the final novel, the chapter documents are gathered 
together in a single InDesign book.

Why Gateway Cares
A Gateway Project Book might have a number of authors trying 
to work on separate parts at the same time. A document can only 
be edited by one person at a time. To allow everybody to work at 
the same time, you can break the book into separate sections in 
separate documents for different people to work on simultaneously. 

By collecting all these documents in one book InDesign handles 
much of the detail work of keeping the look of the book consistent 
and keeping track of page numbers and more.
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Your First BookDocument Sharing

The Style Source

What To Do
If you are starting fresh, just make as many copies of the Gateway 
Template as you need. Rename them maybe just with numbers like 
the illustration on this page. Or you could name them after the 
part of the final document they represent “Project-Intro”, “Project-
Research”... Or you could name for the owner of each section or... 
Save them all in your central location: FTP site, Dropbox, etc.

Then go to File: New: Book. This creates a new file that contains 
Book information for your collection of documents. Put it in the 
same place as the documents. Give it a nice name.

When you say OK on the New Book dialog it creates the file and 
opens a new panel for your book. At first the Book is empty. It 
needs to have documents added to it.

Click the + button on the Book panel and add the documents you 
need. You can multi-select in the open dialog to get them all at 
once.

All your documents are listed in the Book panel. You can drag 
them up and down to reorder them. InDesign keeps track of the 
page numbers.

Style Source
In order to help you with consistency, InDesign uses things called 
Styles. If a style is changed in one document of a book, should that 
change be reflected in all the other documents or should it be fixed 
to match the rest of the documents?

One document in a book is the Style Source. Changes made in the 
Source propagate to the other documents. Changes made in other 
documents are fixed to match the Source. Change the Source by 
clicking the icon in the Book panel.

Existing Document?
If your document already exists, save it with different names then 
in each document delete the pages that shouldn’t be there. Add the 
documents to a new book in the usual manner.
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Basic Shape ToolsShape Creation

Line

Pen

Rectangle

Ellipse

Polygon

Baby Illustrator
InDesign includes tools for creating graphics. For what they do, 
they are the same as Illustrator. It’s just that they don’t do half as 
much as Illustrator.

In this document there are lots of little graphics that were done 
right here in InDesign. Like these... 

They are great for little illustrations and design elements.

You 
can even 

use them to 
c r e a t e 

some  

odd 
shaped text 

frames if 
you feel 

l i k e 
it.

But if you need to draw something with powerful tools, organiza-
tional complexity - a real illustration - then just use Illustrator and 
import the graphic.

What Tools?
There are the basic shapes, straight lines and the pen tool with all 
its support tools. They all have stroke and fill. You can use Path-
finder to combine shapes into more complex forms.

Here’s a quick run down of them so you can get feel comfortable 
with them.
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ModifiersShape Creation

Click and drag

Shift-Drag

Alt-Drag

Alt-Shift-Drag

Space-Drag

Make a Shape
Pick the Rectangle tool or maybe the Ellipse tool on the fly-out 
menu (see page 8).

To make a shape just click and drag on your document somewhere. 
This draws the shape from corner to corner.

Make a Shape Differently
If you hold down Shift while making a shape, it’s width and height 
are forced to be equal. This makes rectangles into squares and el-
lipses into circles.

If you hold down Alt while making a shape the first point you 
clicked becomes the center, not a corner.

You can hold down Shift and Alt at the same time.

If you hold down space while creating a shape you can move the 
shape before it is finished. This is great for tweaking position as you 
go. Yes, it really is better than just making the shape then moving it.
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Pen ToolShape Creation

Add Anchor Point Tool

Convert Direction Point Tool

Delete Anchor Point Tool

Direct Selection Tool

Pen Tool

Click and Drag
The Pen tool is for making complex shapes by manually placing 
and smoothing all the corners.

A shape in InDesign has Anchor Points, these are points through 
which the shape must pass. An Anchor Point has Handles that 
describe the amount of curve and its direction as the shape passes 
through the Anchor.

If you click with the Pen tool you get a hard corner. If you click and 
drag, you get a smooth curve with extended Handles.

Don’t worry about making a mess, most of us find the pen tool 
hard to get used to.

Adjust
Use the Direct Selection tool (the white arrow) to select Anchors 
and Handles and adjust them. If you hold down Shift while adjust-
ing a Handle, it snaps to 45 degree angles.

Sadly, you can’t use the Alignment panel on individual Anchors 
like you can in Illustrator.

Further Adjust
Use the Add/Delete/Convert tools to further adjust your shapes. 
Add and Delete Anchor tools do just what they suggest. You have 
to pick pretty close to a shape or anchor for InDesign to figure out 
what you want to do.

The Convert tool does three related things.

•	 Click on an Anchor and let go - it removes that Anchor’s 
Handles and makes the Anchor a sharp corner.

•	 Click and drag on an Anchor  - it drags out new Handles and 
makes that Handle smooth.

•	 Click and drag on a Handle - it breaks the smooth line 
between the handles, making a sharp point but it keeps the 
handles.
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Select Move Rotate Sizepage 17

Rotate

Scale

Move / Duplicate

Rotate

Scale

Selection / Move / Duplicate

Reference Point Tool Reference Point Marker

Transform
That’s the computer graphics geek word for “move and stuff ”. But 
since it appears on the InDesign menus, I thought I’d show it to 
you.

Move
The Selection tool (black arrow) also works as the Move tool in 
InDesign. Just click and drag on an object.

Duplicate
If you hold down Alt while moving something, it makes a copy.

Rotate
The rotate tool spins things around on the page.  If you hold down 
Alt after you start rotating, it makes a copy. If you hold down Ctrl  
after you start rotating, it moves it instead.

Scale
The scale tool changes the size of things.  You can also change the 
size of something by selecting it and then dragging the grips that 
appear. In fact, that is the recommended way. See the next page.

Reference Point
Rotation and scaling always happen about some center. The point 
which stays where it is. You can set this point two ways.

•	 Click - With the Rotate or Scale tool selected just click 
anywhere in on the document to change the Reference Point 
Marker.

•	 Tool - With the Rotate or Scale tool selected the Reference 
Point Tool appears on the Control panel. You can use this so 
specify corners, edge midpoints, or object center.

Wait - There’s More
The Control panel has lots of controls on it for transforming ob-
jects. If you know you want to rotate something exactly 27 degrees, 
do it there. If you know you want something positioned exactly 
2.718 inches from the left margin, do it there.
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Resize vs. ScalingShape Manipulation

Original

Resize - No modifier keys

Scale - Ctrl held down

Lorem Ipsum

Lorem Ipsum

Lorem Ipsum

Different Ways - Different Results
InDesign has two ideas for changing the size of an object. 

Resize
The first way is to Resize an object. This means just giving a differ-
ent width and/or height for it. For artwork it works like you might 
expect. For text and images which are contained inside another 
object (their frame) then what gets resized is the frame. The text 
and the image are unchanged.

Scale
To Scale in InDesign is to affect all aspects of an object. On art-
work scaling not only reshapes the art, it also changes the stroke 
weight. The difference shows best here on the text example. On 
text and images it also changes the content, the text or image. 

How
If you are using the Select tool and working with the grips, use the 
Ctrl key to manage which sort of size changing you do. You can 
also hold down Shift to maintain proportions.

If you are using the Scale tool... I couldn’t make this work consis-
tently. I don’t know if it’s a bug or if it’s me or if it has been fixed 
since CS4. Short answer? Don’t use the Scale tool to click and drag.

Which One
It depends.

•	 Artwork - For vector art it could easily go either way. You may 
want to change the whole appearance or you may just want 
to change the shape and keep the appearance the same.  You 
choose.

•	 Text - For a block of text that is meant as something to be 
read then you probably just want to resize the frame to make 
it fit differently on the page. For an item of text that is more 
like artwork in its use the artwork rules apply.

•	 Images - Typically you want to scale.
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Pathfinder PanelShape Combination

Original shapes

Add

Subtract

Intersect

Exclude Overlap

Minus Back

Build Up Complex Shapes
If you need a greek cross you could draw it carefully with the pen 
tool, or you could just use Pathfinder to combine two identical 
rectangles. If you need a donut you have to use Pathfinder to com-
bine two circles.

How
Make some shapes. Select them all and then press a Pathfinder 
button.

•	 Add - is straight forward.
•	 Subtract - removes all of the shapes from the rearmost shape
•	 Interset - keeps only the places where all the shapes overlap
•	 Exclude Overlap - keeps only the places where an odd num-

ber of shapes overlap. This can lead to some interesting pat-
terns.

•	 Minus Back - is like Subtract but the base shape is the front-
most one.
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Stroke and FillShape Appearance

Typical default appear-
ance. Slim black stroke 
with white fill.

Wide blue stroke.

Blue fill.

Blue fill with wide 
yellow stroke

Red fill with yellow 
stroke, dashed with blue 
gap color.

Simple line with wide 
blue stroke.

Same line with End 
arrowhead added.

Very Expressive
A shape starts as just an outline, but then it gets an appearance 
applied to it. Every shape has two primary parts:

•	 Stroke - the line that traces around its edge. This line can not 
be drawn or it can have a thickness, called weight, and a color. 
It can also have a Type for a more ornamental look and it can 
be dashed.

•	 Fill - color applied to the area a shape encloses. If a shape is 
open, like a U, then the fill stops at an invisible straight line 
connecting the start and end of the shape.
InDesign does not have Patterns, you have to go Illustrator 
for that, but it does have Gradients. More on “Gradient” on 
page 63.

How
Select an object then change the attributes you want.

You can access Stroke and Fill color on the toolbar. If you double 
click the tiny color indicators a color picker pops up to let you set 
a color. 

Under the tiny color indicators are the even tinier frame and text 
buttons. Text in InDesign lives in a frame and the frame can have 
its own color different from the text. See the next page.

Or you can go to the Color and Stroke panels where the buttons 
are all a little bigger.

The pair of squares represent Fill and Stroke color. Which one is 
in front is the one you are changing. Just click on the one you want 
then pick a new color.

The tiny curved arrow to the upper right of the two squares swaps 
places, Fill becomes Stroke,  Stroke becomes Fill.

The Color panel seems to have a mind of its own. If you go to the 
Panel Menu you can tell it which color picker you want. 

The Stroke panel has all the controls for Stroke Weight, Type and 
even if you want a shape to be an arrow.
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Not Just For ShapesShape Appearance

Text frame with a red 
frame stroke.

Text frame with yellow 
frame fill.

Text frame with blue 
frame and text strokes, 
gray frame fill and yellow 
text fill.

Image frame with yellow 
frame stroke.

Image frame larger than 
image with yellow/blue 
frame stroke and red 
frame fill.

Lorem ipsum ur 
sit amet.

Lorem ipsum ur 
sit amet.

Lorem ipsum ur 
sit amet.

Frames Have Appearance Too
Text and Images are each contained inside a shape called a Frame. 
Since a Frame is just another Shape, it can have a Stroke and Fill. 
Images inside a frame are just images and have no Stroke and Fill 
of their own. But text inside a Frame does have its own Stroke and 
Fill. Wherever you see the two squares two switch between Fill 
and Stroke you will also see a small square and a small T. These are 
for specifying whether you want to change the appearance of the 
frame or of the text within it.

Frames Have Shape Too
Text and Image frames are rectangular by default, but you can use 
the shape editing tools to change them. You can even convert exist-
ing artwork, even complex Pathfinder results, into a frame for text 
or images.
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EffectsShape Appearance

Frame stroke: 100% Opacity. 
Frame fill: 50% Opacity

Text: Drop shadow. 
 
Curve is behind text frame.

Without Object: Knockout

The text picks up the blue and 
can’t see through it.

With Object: Knockout

The text ignores the blue and 
is transparent through to the 
background.

Lorem 

Lorem Lorem 

Simple Transparency
A very common desire is to have text on a transparent frame partly 
blocking out the background but still allowing it to show through. 
This is accomplished on the Effects panel.

If you just open the Effects panel and change opacity to, say, 50% 
the whole thing will fade and your words will be hard to read.

See that “Object” is selected? Select “Fill” instead and change its 
Opacity.

You can also change the blend mode where it says “Normal” for 
Object, Stroke, Fill, or Text.

Typically text is is drawn as appearing in front of the background. 
If you need the text to have a transparency effect that interacts with 
the background but not the frame, Objects and turn on “Knockout 
Group”.
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EffectsShape Appearance

Original

Outer Glow

Satin

Gradient Feather

Drop Shadow

Inner Glow

Basic Feather

Inner Shadow

Bevel and Emboss

Directional Feather

Hi

Other Stuff
On the Effects panel there is a little button with “fx” on it. It hosts 
a long list of effects that can be applied to objects or parts of their 
appearance.

I won’t say they are unsuitable for design documentation, but do 
use them carefully. A bit of drop shadow can help bring something 
forward in a busy situation. A bit of inner shadow is sometimes a 
nice effect on title text. They can also be used to make a diagram 
seem a little more physical... or a little more painterly.

Here is a quick demo of all of them at their most basic and few 
fancier combinations.
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Use These All The TimeSwatches 

Reusable, Alterable Color
A Swatch is a saved color. You can give a swatch a nice name to 
help you remember what it is for.

Whenever you do anything with color in InDesign, fill a graphic 
background element, draw an important arrow, color a character 
style... anything, you should use a Swatch and not just some color 
you picked off the color picker.

The reasons are back there on page 4. 

•	 Consistency - You don’t want your document to be a chaotic 
mess. If there is a color used for some purpose it should al-
ways the that color throughout the document. Next time you 
need it you can use a Swatch to just get the exact right color 
in one easy click. “Oh, the swatch named ‘Callout Green’ is 
the one I want.

•	 Modifiability - You don’t have to finalize your colors until 
the very end. If you have 137 pages written and find out that 
Callout Green is printing a little dark, you can edit just one 
Swatch, put a little more white and a little less cyan and ev-
erywhere in the document that color is used gets corrected.

And a third reason:

•	 Ugly Mess - Using Swatches pushes some discipline on you 
and prevents your document from using so many colors it 
looks un-careful.

How
On the Swatches panel select an existing swatch then click the 
New button. A new Swatch is made. Double click on the swatch 
to edit the color and give it a useful name (you have to turn off the 

“Name with Color Values” checkbox, but that’s OK).

...Or...
When you double click on the color chips on the tool bar the color 
picker dialog that comes up has a button on it to Add Swatch. You 
can design a color, hit the button and then do another and another. 
But remember to go to the Swatches panel and change the names.
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TransportationSwatches 

Moving to Other Programs
If you are going to make art in another program (Illustrator, Pho-
toshop...) that you want to integrate into your document it is good 
to use the same colors in that art. You can share swatches between 
different programs by saving to a Swatch Exchange file.

How
Select the swatches you want to save. Use shift to select ranges and 
control to select multiple individual swatches.

On the Swatches panel menu select “Save Swatches.”

Be careful where you save the swatches. In testing every program 
saved somewhere different. You should probably just save the 
swatches to the same place as the document.
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They Live OutsideAdding Images

Efficient
It is important to understand that InDesign does not store your 
images in the document. Instead it stores a low resolution preview 
image in the document and a link, like a pointer “over there”, to the 
actual file with the actual artwork in it. It is a lot like AutoCAD’s 
external references (XREFs).

Doing it this way has two important advantages:

•	 Size - if every image were stored in the document the file 
would get huge and hard to manage. Even small documents 
would probably be slow to manipulate. Instead InDesign only 
has to worry about the full size of an image every now and 
then. It makes it much more nimble in computer memory to 
swing around small thumbnails.

•	 Openness - we’ll call it. Images can be edited, even replaced, 
without having to open InDesign, or dealing with any sort of 
hassle. If the document points to the Winter Collage on the 
hard drive and your client (or intern or rendering service or...) 
sends you a new copy of the image all you have to do is put it 
in the same place as the old one with the same name and next 
time you open the document the new version of the image is 
sitting right where it is supposed to be.
You can reuse common material, a company logo for instance, 
from a central repository and not worry that updates to the 
logo won’t be picked up on every single sheet of your market-
ing material.
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PlaceAdding Images

Simple But Tedious
Go to the File menu. Pick Place and a file open dialog appears. 
Select your image and click the Open button.

Now you have two options

•	 Click - and let go. The image is dropped on the page at a size 
that may be inconvenient. Then you can scale it and be on 
your way.

•	 Click and Drag - and let go. You draw out a rectangle and 
the image fits nicely inside it. You may still need to scale and 
move it, but at least it started out conveniently.

Multiple Images
You can select more than one image in the file dialog. If load a 
number of images at once: You can undo a single place by hitting 
Ctrl-Z and then try again.  You can hit Esc to discard an image 
and move to the next one. You can use the left/right or up/down 
arrows to move through the images. 

However...
That’s the hard way to do it. There is a better way.
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Drop From OutsideAdding Images

Bridge - for finding, placing and managing  images.

Parts Bin
When you build model, you keep a bunch of useful stuff right there 
on the table where you are working. Not stuck in some shoebox 
on a shelf on the other side of the room. Similarly, there are ways 
of keeping your content available and just grabbing it when you 
need it.

Well, it’s really just one way: Have some program that shows you 
your images in their folders on the disk and allows you to drag and 
drop them into your document.

Bridge
Adobe has a program called Bridge that does the job. It has power-
ful features for working with other Adobe products and since it is 
Adobe it can thumbnail PDF and Illustrator files with ease.

Mini-Bridge
InDesign has a panel called Mini-Bridge which puts Bridge right 
at your fingertips. It is great to have your content right where you 
are working. Look for Mini-Bridge on the Window menu.

Explorer
If you don’t fancy Bridge, you can use your operating system’s file 
browser. Windows Explorer, Mac Finder or what have you. They 
have ways of showing thumbnails of images and are already famil-
iar to you.

Other
There are third party image thumbnailers which you may prefer for  
your own reason. As long as you can select an image and drag and 
drop it to another application it should work just fine.

How
Open the image browser of your choice. Navigate to where your 
images are. Select one or more images then drag and drop them 
onto your document. It is that easy.

InDesign then has you place images normally.
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It’s kind of  tricky...Images In Frames

No frame appearance. 
Image fills frame.

Frame fill, stroke and effects. 
Image smaller than frame.

Frame reshaped, fill, stroke and effects. 
Image resized large and rotated in frame.

Simple frame stroke. 
Image resized in frame. 

How it looks on a page. Behind the scenes.

Image Frames

Lorem ipsum dolor sit amet, consec- 
tetur adipiscing elit. Vestibulum laoreet 
nunc at posuere interdum. Integer 
laoreet volutpat tortor. In sollicitudin 
vel purus condimentum aliquet. Phasell- 
us consequat congue lacinia. Morbi rhon 
cus nibh ac lobortis aliquet. Sed volu- 
pat vel velit eget convallis. Proin conv- 
allis mi et sem tempus tristique. In eu 
tellus nunc. Maecenas quis eros sem.

Image in a Frame
It isn’t that tricky, it’s just unexpected so it confuses people at first.

An image in InDesign does not just sit by itself on the page. It sits 
inside a Frame. Just like a picture frame you would hang on your 
wall, the frame has its own appearance and shape and the image 
floats freely inside it; you can decorate the frame ornately or make 
it invisible. You can shrink the image down inside the frame or 
blow it up huge and rotate it. You can modify the frame freely, it is 
just another Shape and the Pen tools work on it.

Two things that might help:

•	 Contents - You can move the image inside the frame and 
frame stays in place.

•	 Container - You can move the frame and the image inside 
comes along with it.
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Manipulating the ImageImages In Frames

Single click the image (But not the Gray 
Bullseye) to edit the containing frame.

Double click the image or single click the 
Gray Bullseye to edit image inside the 
frame. 

How
The trick is for InDesign to know if you mean to manipulate the 
frame or the image inside it. It is similar to AutoCAD’s viewports 
on layout tabs and switching between paper and model spaces.

•	 Frame - just select the frame and manipulate it.
•	 Image - either double click on the frame or click once on the 

bullseye in the middle of the picture.

When you select the frame, the highlight color matches the layer 
the frame is on (light blue by default for Layer 1). When you have 
the image selected the highlight color is.. I’m not sure, something 
very different but not opposite (orange by default in contrast with 
the light blue).

Aargh
It is a little too easy to click on the bullseye and end up moving the 
image in the frame when you meant to move the frame. It seems 
humans are a lot better at perfectly hitting the center of a rectangle 
with a mouse without really trying than you’d think.

If this happens to you, and it will... oh yes, it will, just undo the 
move and double click on the image and make sure you get the 
selection color change.
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Just Hold Ctrl-ShiftResizing Images

Start position...

Just resize the frame and it crops the image

Ctrl-Shift: Resizes image and frame 
proportionally.

Ctrl: Resizes image within the frame. 
Distorts.

Shift: Resizes the frame proportionally.  

What You Really Want
When you select an image with a single casual click and resize it 
by the grips you resize the frame but not the image inside it. This 
is usually not what you want.

We touched on this back on page 20, but it is here with images that it 
becomes immediately obvious to the new InDesign user. As useful 
as live cropping can be, you really want to resize the image.

Short Answer
Just hold Ctrl-Shift.

•	 Ctrl - makes the image resize with the frame
•	 Shift - makes the resize proportional so the image doesn’t get 

distorted.
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FittingResizing Images

Start position... Center Content

Fit Content to Frame Fit Content Proportionally

Fit Frame to Content Fill Frame Proportionally

Mismatch
Sometimes your image and your frame don’t match or aren’t what 
you would like. If you just made a resize mistake (you forgot to 
hold ctrl-shift, didn’t you?) you can undo and try again. But that 
isn’t always an option. For that we have Fitting.

Fitting tries to address all of the various ways an image and its 
frame might relate to each other than “custom”.

How
Right click on an image and about halfway down the menu is the 
Fitting sub-menu. It is also on the Object menu at the top of the 
screen. Pick an option.

Hot Keys
Notice that many of the fitting options have hot keys assigned 
to them. When I am doing page layout, I memorize the two that 
work best for me: Fit Content Proportionally, Fit Frame to Con-
tent. Then all I have to do is select one or more images, Ctrl-Alt-
Shift-E, Ctrl-Alt-C. It’s easier than it sounds when your fingers 
know how to do it without thinking. I promise.

Side Answer
When you select an image (or image frame) there are a bunch of 
buttons on the Control panel that address fitting. If find them a 
little more difficult to use, but maybe that’s just me.



37Gateway Software Workshop
InDesign

How Dense Are They?Resizing Images

Preparation
First you’ll have to go to the Links panel menu. Panel Options.  
Under “Show Column” turn on “Effective PPI”.

Now back in the Links panel you should see another number for 
each and every link.

Pixels, PPI, EPPI ...
Images have two kinds of size:

•	 Actual - this is the number of pixels used to make up the 
image. 

•	 Physical - this is how much space in the real world the image 
thinks it should take up. Usually this is expressed as “pixels per 
inc” (PPI). Then a actual size divided by PPI gives physical 
size.

And then there is:

•	 Effective PPI - which should be thought more of as density 
than size.

After you scale an image the actual pixels it has take up a certain 
amount of space on the page in your document, regardless of the 
image’s expected size. This size on the page determines the Ef-
fective Pixels Per Inch (EPPI) for your image. This is the number 
that really counts. How close together are your pixels? How big 
are they?

If your image is 1000 pixels wide and you scale it to 4 inches on the 
page, it is 1000 ÷ 4 = 250 Effective Pixels Per Inch.

You can see to the left that this document has images with EPPIs 
all over the place. You don’t want EPPI to be too small or the 
pixels will start to show and the image will look bad. You don’t 
want EPPI to be too high because the size of the thumbnail in the 
InDesign file is related to the actual image size. Also, it takes time 
for InDesign to read every image and display it or get it ready for 
print and it takes longer for larger images.
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How  Small Should They Be?Resizing Images

65 eppi 100 eppi

150 eppi 300 eppi

Do It Yourself
Make a test page. Print it out. Check the images and see if you 
agree. Warning, this PDF may have been resampled to lower qual-
ity than is indicated on this page.

300
Barring specialist needs, 300 EPPI is good enough for anything 
you will print on a laser or ink jet printer. If you are will use a 
professional print shop ask them what they want.

You want the best quality for sharp edges and clean delicate line 
work. If it is really important, make a test. Maybe you have to go to 
450 EPPI or 600 EPPI.

150
This is about the edge of quality. It depends on the eyesight of the 
viewer, the nature of the printer and the nature of the image. If in 
doubt do not go lower than 150 EPPI.

100
At this low a pixel density your image is not as good as it could be. 
Even if you can’t see the pixels it won’t be as crisp and have as much 
detail as it really could. Avoid using an image at 100 EPPI unless 
you have to. Can you make it a little smaller on the page to boost 
the density? Print a test to make sure it looks okay.

65
You will see the pixels but the quality will be good enough that the 
image will be understandable... And you will look unprofessional.

At 65 EPPI I think there are two options:

•	 Unimportant - The image is not important enough to be in-
cluded in the document and make you look this bad. Discard 
it.

•	 Important - The image is so important it has to stay in the 
document. If that is so, why don’t you have a better quality 
image? Go get one. Go make one. Solve this problem.

•	 Bad Idea - You leave it as is.
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How  Big Should They Be?Resizing Images

Identical
With this page full size on screen these two images look almost 
identical. Zoomed in even one notch the quality difference starts to 
show. But you aren’t supposed to zoom in. Look at the magnifica-
tion circles to see what I see. 

When this document gets turned into the PDF you are reading, it 
will probably resample both images to a lower density than they are 
now. And yes, quality will be lost.

Even though these two image look the same when they are used as 
intended, the one of the left is huge and slow, the one on the right 
is small and nimble.

On The Left	 On The Right

48 layers	 1 layer
154 Megabytes	 0.1 Megabytes
Adds 250 k Adds 120 k
1070 EPPI 138 EPPI
2114 x 6955 pixels 274 x 900 pixels

Anyway...

How Much is Too Much?
Hard to say. It depends on your purpose, your readers, and your 
printer. 300 EPPI is probably just enough for almost everything. 
600 EPPI is, at a guess, adequate for the most demanding and 
capable situations. Any more than that and your readers probably 
can’t see the quality and your printer probably can’t print the qual-
ity.
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Group Them FirstResizing Many Things

If you select a bunch of things and try to 
resize them...

Group them first (Ctrl-G) then resize. 
Ungroup (Ctrl-Shift-G) when done.

You may find yourself disappointed.

Sed exerum hil expliati od 
undella borentum que lab 
isitium dolumen iminvero 
eossum int res deratur?

Sed exerum hil expliati od 
undella borentum que lab 
isitium dolumen iminvero 
eossum int res deratur?

Sed exerum hil expliati od 
undella borentum que lab 
isitium dolumen iminvero 
eossum int res deratur?

Hey, I Said All Of  You
If you select more than one thing then try to resize or scale them 
all at once, it doesn’t work. Only the thing whose grip you clicked 
on changes.

How?
Select the objects. Then Group them. Change the size and they all 
change together. Then Ungroup them if you want.

Careful
If you are using layers, grouping and ungrouping shifts objects to 
all be on one layer (the topmost one, I think). You when you un-
group you will need to remake your layer assignments.

Hotkeys
Use the grouping hotkeys to make your life easy.

•	 Group - ctrl-G
•	 Ungroup - ctrl-shift-G
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Header
Sometimes you resize/rescale an object and want to change some 
other objects to match. Either change by the same amount or 
change to a specific size.

How
Make the change to the one object. InDesign differentiates be-
tween Resizing and Rescaling when you do this. So pay attention 
to which tool you use and how you use it.

Object: Transform Again: Transform Sequence Again Individually.

There are other options on the Transform Again menu. I haven’t 
looked into them at all and don’t know the differences. But I know 
this one works.

Patience
This took a few tries to get right, but it does work and once you get 
it it’s pretty easy. It might make a good custom Keyboard Shortcut.

Make Them All The SameRepeating A Size

Resize for exact size.

Scale for % change.

Resize one element; Select the others; and then -  
Object: Transform Again: Transform Sequence Individually



42Gateway Software Workshop
InDesign

Oh, This Needs Changed
As you make your document you will notice things about the art-
work that needs to be changed. For linked artwork you can’t make 
the edits inside InDesign but the next best thing is possible. You 
can launch the editor directly from InDesign.

How
Right click on your art or go to the Edit menu and pick Edit 
Original.

Photoshop or Illustrator or whatever opens with your file. You can 
make all the edits you want then just save and close. Once you are 
back in InDesign you will see the artwork update. 

If it does not, make sure you didn’t save with a different name. Or 
in a different place. Or as a different kind of file. You can force 
an update on the Links panel. Or if you took a simple JPEG and 
turned it into a multilayer PSD extravaganza, you need to place the 
new file in the existing frame.

Oops, Wrong Program
InDesign opens the art in the program the operating system has 
associated with that file type. But at last check at the BAC, PNG 
files went to Fireworks, JPEG files went to the Windows image 
viewer, PDF files go to Acrobat Reader.  These aren’t really the 
programs you want to use.

Two ways to solve the problem:

•	 Edit With - instead of Edit Original lets you pick the pro-
gram to use. The first time it takes some time to find it but 
after that it pops up the same location so picking the program 
is quick. Sort of.

•	 Change the file association - In Windows Explorer right 
click on a file of the type in question. Open With: Choose 
Program. On the dialog that pops up, select your program, 
browse for it if you have to. Make sure “Always Use...” is 
turned on.

Sadly you will have to do this every time you change computers.

Do It From Inside InDesignEditing Images
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Just Use A Text FrameMaking Text

Just click and drag a rectangle out and then 
type in it and change the appearance and 
whatever you need.

Click and Drag
Text is a kind of content in a Frame. When you select the text tool, 
InDesign is expecting you to click and drag a rectangle to specify 
the location and size of the Frame. You don’t just click the starting 
point.

After you have created the frame you can just start typing.
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Starting and StoppingMaking Text

Problem
Once you start typing, most of your keystrokes get turned into text. 
This is good because you would hate to try to type “vase” and have 
the Selection tool turned on and typing turned off whenever you 
hit the ‘v’ key.

Solution
To stop typing, just hit the Esc key.

Problem
You want to go back to some text and edit it or add more.

Solution
You can use the Text tool then click exactly where you want in an 
existing Text Frame.

You can double click with the Selection tool to switch to text mode.
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Just Use A Text FrameAppearance Of  Text

Ectoreca epudiandel ipsa quo cum sum ipid-
eritem rempori tatur? Ga. Iquam faciantios 
sitempo ress Ehenduntis consedis aliquas 
perferuntur siDae della dolupta tiaero tem. 
Ga. Ibus doluptatur, sit ratae lacimagnam.

Lorem Ipsum

Ectoreca epudiandel ipsa quo cum sum ipid-
eritem rempori tatur? Ga. Iquam faciantios 
sitempo ress  consedis aliquas 
perferuntur siDae della dolupta tiaero tem. 
Ga. Ibus doluptatur, sit ratae lacimagnam.

Lorem Ipsum

Ectoreca epudiandel ipsa quo cum sum ipid-
eritem rempori tatur? Ga. Iquam faciantios 
sitempo ress Ehenduntis consedis aliquas 
perferuntur siDae della dolupta tiaero tem. 
Ga. Ibus doluptatur, sit ratae lacimagnam.

Lorem Ipsum

What’s Black and White and Red All Over?
Your Text can be!

Just like an image has a frame which has its own appearance in-
dependent of the image inside it, so too Text and its containing 
Frame have their own appearance attributes. The Frame is just a 
shape so it has Stroke and Fill. Text is just fancy shapes and it too 
has Stoke and Fill.

How?
Look near the Stroke/Fill color squares. See the tiny rectangle and 
the tiny ‘T’? Those are actually buttons and they specify which col-
ors you are changing. To change the colors for the Frame, click the 
rectangle. To change the colors for the text, click the ‘T’.

If you select some text, you can change the colors for only that 
portion. But you shouldn’t do it that way, you should use Character 
Styles.
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Text Has A ColorPlaceholder Text

Bis reriossum voluptate venis 
sequisti reptam quibus, tesequid 
quo blabore dis delit ut occusdandi 
sapedig natur? Qui atestis nis 
conse lat imperun ducimil imin 
consequam nis eos porrovit que la 
aliquae doluptatem sus a sunt mi, 
qui cupta dollam ium quo bla vo-
luptate porit rehenim porias eatur, 
et volora cuptur?

Ibus maiorro tem eaquam sit om-
nis nos conessitisci quiaectate pra-
tio. Busdant ullorrum, aut rectias 
serum aute con et es moluptam 
estium idelici ius dolorem velecab 
orroritatio. Nonsectur adit rem. 
Cidi consequi occulli cteceaquate 
illecercilia commolo

Section Header

Unbalanced - I wonder if it will 
be OK with the text in?

Balanced - I guess it’s OK then.

Two Modes of  Operation
When creating a document there are two modes of operation. They 
are Designing and Writing. For many documents these are done 
by different people and/or at different times. To help out with this 
use Placeholder Text.

What?
Placeholder Text is automatically generated text that does not 
mean anything but fills a Text Frame and is intended to be re-
placed at a later date. For more information see Wikipedia and 
Lipsum.com.

Why?
There are a number of ways Placeholder Text helps out.

•	 Reminder - so you know where text is supposed to go
•	 Manipulation - if you are going to move the text around, it’s 

easier to click on a block of text if there’s a block of text there.
•	 Mass - a block of text is an important visual design element. 

You don’t want to lay out your pages without taking into ac-
count how they will actually look.

•	 Color - the way a block of text looks depends on the font, the 
line spacing (we call it “leading” with a soft ‘e’ sound, like the 
metal). This texture, this quality of gray, is called color and it 
is a design element too. You don’t want to lay out your pages 
without taking into account how they will actually look.

How?
Select a text frame. On the menus, Type: Fill With Placeholder 
Text.

What?!
It looks like Latin; why? Check those links up there for a full dis-
cussion of the history. What’s good is that by not being English 
it does not distract the layout artist and also that it is easier to 
recognize on a quick glance that it needs to be replaced.
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Feature Rich BoxesText Frame Options

Default settings

Inset Spacing

Vertical Justification - Center

Columns

Torum, officiant most, si dolupta spictus aut hil in cone ex el in 
natetur, ute nem explab ipsa ium arum, omnisin exped elliae. Et 
denti simusa velicip sandente modictem enis id magnatem expii. 
Tore, exernatus que ium faccupt atumeniment ut hicti autatquam 
qui dolut acia dolo magnimi nctotas dolor mostem sequas nem 
ipsant fuga.

Torum, officiant most, si dolupta spictus aut hil 
in cone ex el in natetur, ute nem explab ipsa ium 
arum, omnisin exped elliae. Et denti simusa ve-
licip sandente modictem enis id magnatem expii. 

Torum, officiant most, si dolupta spictus aut hil in cone ex el in 
natetur, ute nem explab ipsa ium arum, omnisin exped elliae. Et 
denti simusa velicip sandente modictem enis id magnatem expii. 
Tore, exernatus que ium faccupt atumeniment ut hicti autatquam 
qui dolut acia dolo magnimi nctotas dolor mostem sequas nem 
ipsant fuga.

Torum, officiant most, si do-
lupta spictus aut hil in cone ex 
el in natetur, ute nem explab 
ipsa ium arum, omnisin exped 
elliae. Et denti simusa velicip 
sandente modictem enis id 
magnatem expii. Tore, exerna-

tus que ium faccupt atumeni-
ment ut hicti autatquam qui 
dolut acia dolo magnimi ncto-
tas dolor mostem sequas nem 
ipsant fuga.

Lorem Ipsum

Not All Text Frames Should Be The Same
Text Frames have some special features related to their role as con-
tainers for text. They address... well, just look at the pictures.

How?
On the Object menu, Text Frame Options. You can also get it off 
the right click context menu or, my personal favourite, there’s a 
hotkey, Ctrl-B.

What?
Normally Text fills the frame as best as it can. Depending on what 
kind of appearance the frame has and how you lay out your guide 
lines, this may not be a problem. Other times it can be a little 
crowded.

For example, the captions on this page are in frames that are right 
up against the frame they are captioning. This zero spacing is the 
easiest for me to do, but it would look bad. So each caption’s Frame 
has a top inset of three points.

Other times, particularly for small callout boxes, it’s nice to have 
the text vertically centered.

Something I see frequently in portfolios is a block of text that is 
not very tall but is as wide as the page. This looks bad and is hard 
to read. Text Frame Options allow you to turn one frame into a 
number of more readable columns.

Take Note
Left/right centering of text is handled as a property of the para-
graph of text. Make the change in a Paragraph Style.

Top/bottom centering of text is handled as a property of the Text 
Frame.

The two are done in entirely different places to entirely different 
things. It can be a bit confusing until you get used to it.
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Possibly Most ImportantParagraph Styles

Sed quam et quibus magnihi 
Vit fuga. Doloris eriorum quatibus cum 
con reius volent molor sandes ipsundi os-
sequiam ducid quundemoles aborpor aut 
ab inis doluptur modi quo ommos quo ex 
et asperati remporestium volor sumquam 
ut enditaessit venihil ium que nullecum 
eos ad magnis atur, id maio officid eature-
peris dollias eaquost. 

Iinum eum dempe officid quis a pro 
esciustia que dolupta quibuscienis non-
ecaborro optium hillest rumque dolent aut 
doluptatur sum a quo dolorere, cullesc ide-
liam am es rae quos enetur reped quaecta 
epelis sim reprepedit volestem etur, officil 
moluptatur, sam ulparch ictotatem incta-
tur, consequi bearibus re sanda sendipicti 
as sectior asimo ommolor untustis assedit 
ionectat.

Es dolupita cus es aut quaes aut officia ni.

Never Ever Ever
When you are editing text, there are a lot of tempting controls at 
the top of the screen for changing all sorts of things: font, tracking, 
leading, alignment, drop caps... You can go to the Color panel and 
change all the colors like we talked about on page 46.

But don’t do this, please. When you touch those controls, you make 
changes that can only be fixed or updated or removed by hunting 
down each and every one. It is the thing most likely to turn your 
document into an unprofessional lack of consistency. And it’s not 
just that it looks bad, it is actively confusing. People rely on the 
subtle cues of text formatting to tell them about the document: 
what is what, what to read, what to skip, how things relate to each 
other.

So what should you do?

Paragraph Styles
For each job text is doing in your document you should create a 
Paragraph Style. For instance, your document may use Headers, 
Body Copy and Captions. Make styles.

Then, when you are typing, just like this Text Frame right here, 
if you type something that should be a Header you just click on 
the style in the Paragraph Styles panel and it formats the whole 
paragraph. It is even possible to set it up so that after you type the 
Header and hit return.. the very next paragraph is Body automati-
cally.

Then later when you want to change a font or an indent or spacing 
or underline color or... you only have to change it in one place 
instead of three hundred and forty seven.

Oops, three hundred forty eight.

...nine
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OverviewParagraph Styles

How
On the Paragraph Styles panel click the New Button.

Oh, wow.
A big dialog pops up with a huge number of options. Fortunately 
you don’t have to worry about many. They’re all really interesting 
and fun, but to get started there are only three categories that you 
must look at:

•	 General - Name the style here. When you get a little more 
experience use “Based On” and “Next Style”. They are useful.

•	 Basic Character Formats - This is where you pick your Font, 
its Style and Size. Later if you are writing a paper that is sup-
posed to be double spaced, come here and change “Leading.”

•	 Indents and Spacing - This is where you find what you may 
think of as “justification”. InDesign calls that Alignment. 
Also here is the important “Space After” and the slightly less 
important “Space Before.”

That’s it. The only places you have to look and the only things you 
have to change. For now.

Applying
Paragraph styles apply to the whole paragraph the cursor is in. You 
don’t need to select all the text in a paragraph, that would be an-
noying.

If you want to change only some small parts of a paragraph, make 
a word or three bold or italic, for instance, then what you want are 
Character Styles. They are similar to Paragraph Styles but affect 
only selected text. On this page, “Applying” is a paragraph with  a 
Paragraph Style that I named “Header.” “General” is in a paragraph 
with the style “Body - Bullet” but the word itself has a Character 
Style applied to it that I name “Bold.”
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GeneralParagraph Styles

Bookkeeping
This tab contains settings that don’t directly affect how the text 
appears.

•	 Style Name - A style should have a name so you know what 
it’s for. This document has some simple ones: Header, Body, 
Caption; and some more specialized ones: Body After Bullets, 
TextFrame3dMatch. Make the style’s purpose clear in the 
name. You may have to come back in six months and wonder 

“what’s that for?”
•	 Based On - Specify a Paragraph Style that this one should 

copy values from, its “parent”. If you don’t set a value in this 
Style, it uses the value from its parent.
For instance, my Caption style does not say what font to use, 
only that it should be 10pt and italic and based on Body. If I 
change body from Caslon to Arial, Caption will too.
This is a little fancy so don’t worry if you don’t get it right now, 
you can live without it.

•	 Next Style - Specify a Paragraph Style for the paragraph that 
comes after a paragraph with this Style. This is great. You hit 
enter and the next paragraph is already the right style. It isn’t 
a hard rule, you can change the style of the next paragraph 
when yo are typing it and InDesign won’t try to “fix” it for you.
For instance, this document has headers on all the pages. A 
header is always one paragraph only and is almost always fol-
lowed by a paragraph of Body. So I have Header’s Next Style 
set to Body. 
I type a few words of text, set the style to Header, then hit 
Enter. The next paragraph is set to Body and I keep typing 
without have to go click on the Paragraph Styles panel.
You can see on the left that Body’s Next Style is set to “Same 
Style”. That is because I’m probably going to type another 
paragraph of plan text and not a header or something else 
after my first paragraph of Body.
This is another slightly fancy trick so if you don’t get it right 
yet, don’t worry about it.
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The Regular Font Stuff
•	 Font Family - the name of the actual font (technically “type-

face” but that’s not the term InDesign chose). There are tons 
of fonts to chose from, pick one that suits your purpose. A 
font makes a statement. Formal, modern, clean, classic, re-
served, casual...

•	 Font Style - combines weight (bold, etc.) with italic, and 
width (condensed, wide, etc). It only offers styles that the 
selected Font Family supports. If your computer has Arial but 
not Arial Bold, Font Style will not offer Bold and InDesign 
will not try to fake it without help. I guess this is a profes-
sional quality thing.

•	 Size - um... size. The traditional units for size are points. Ever 
since 1984 a point has been 1/72nd of an inch. Typical sizes for 
body copy are in the 10pt to 12pt range. The size of text and 
the line to line spacing increases with size within the same 
font. There is no guarantee that 10pt in one font will have the 
same sized letters (glyphs) than 10pt in another. 
Because of this when you change your font go back and check 
it’s color. What was a delicate striped filigree in Palatino may 
look like a battered checkerboard in Times New Roman.

•	 Leading - This is line spacing. When the value is in parenthe-
ses that is InDesign telling you that is the default spacing for 
the font. You can change it if you want to.
Indeed, if you are using a sans serif font for your body copy, 
check to see how well it reads, how dense it looks. You may 
want to increase Leading by a point or two.

The rest are cool but you don’t need to look at them. Except for 
Kerning, but not here. That deserves its own page.
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First Line Indent Space After Other. Just to show you can.

Epudae incim fugit et, sa-
musant aut volorer untempo 
rroion eiusdania sit odia 
essumet adipsam eum aut 
adisimus nimus et laut pel 
ipsa voloria dolorro cor sitecta 
sinctatia w

Corrorp ostrum dolore, 
ulloribuscit ad que eiciisintio. 
Nequaccab idellic tempell 
igenten tiuntis volorit asitatiat.

Mi, vendant eum aligen-
del mollit a eiusam, velesti 
officil idit pel ipsam fugitaten-
dae coratur, sunt ipsus.

Ut moluptae incte 
ventum nes ut et, coreict ota-
tur? Qui nonsequ iaecuptis 
pro omn

Epudae incim fugit et, sa-
musant aut volorer untempo 
rroion eiusdania sit odia 
essumet adipsam eum aut 
adisimus nimus et laut pel 
ipsa voloria dolorro cor sitecta 
sinctatia 

Corrorp ostrum dolore, ul-
loribuscit ad que eiciisintio. 
Nequaccab idellic tempell 
igenten tiuntis volorit asitatiat.

Mi, vendant eum aligendel 
mollit a eiusam, velesti officil 
idit pel ipsam fugitatendae 
coratur, sunt ipsus.

Ut moluptae incte ventum 
nes ut et, coreict otatur? Qui 
nonsequ iaecuptis pro omn

E pudae incim fugit et, 
samusant aut volorer 
untempo rroion eius-
dania sit odia essumet 
adipsam eum aut adi-
simus nimus et laut pel 
ipsa voloria dolorro cor 
sitecta sinctatia 

C orrorp ostrum dolore, 
ulloribuscit ad que 
eiciisintio. Nequaccab 
idellic tempell igenten 
tiuntis volorit asitatiat.

M i, vendant eum aligendel 
mollit a eiusam, velesti 
officil idit pel ipsam 
fugitatendae coratur, 
sunt ipsus.

The Shape of  a Paragraph
These values have a lot of say over how a paragraph looks on a page. 
Not all the say, Font Family and Leading are pretty important too. 
But this tab can make a block of text look like a wedding invitation 
or a Bauhaus instruction manual.

•	 Alignment - You may think of this as Justification. InDesign 
uses the word “justify” in a way that is not quite what you may 
be used to. There are samples of all the options and more talk 
on page 54.

•	 First Line Indent - For the traditional paragraph indicator.
•	 Space After - For the other paragraph indicator.

The other stuff is handy and you should look at them, but they 
aren’t must know basics.

Over Indicate
There seems to be some controversy over these two points, but 
I’ll tell you the ones that make sense to me. The both involve the 
idea that paragraphs should be indicated so people know where 
to breathe, where to expect new ideas to crop up, so they can 
get a sense of the flow of the writing. So, how do you indicate 
paragraphs? Two very common options are First Line Indent and 
Space Between (implemented here as Space After).

•	 Controversy #1 - Since either one of these is adequate to 
indicate a new paragraph, it is silly to use both of them.

•	 Controversy #2 - Since the first paragraph is obviously a 
paragraph, it should not have a first line indent or space in 
front of it.
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Left Left Justify Full Justify

Center Center Justify Towards Spine

Right Right Justify Away From Spine

Ad milic toreptas esti 
sumquo corrum elibus-
dant aut eaque sequa 
pelen st, quoquae ipitorat 
fugias sersper ersperu 
mquibus eatur sedion ea 
suntisum

Ad milic toreptas esti sum-
quo corrum elibusdant aut 
eaque sequa pelen st, quo-
quae ipitorat fugias sersper 
ersperu mquibus eatur 
sedion ea suntisum

Ad milic toreptas esti 
sumquo corrum elibus-
dant aut eaque sequa pelen 
st, quoquae ipitorat fugias 
sersper ersperu mquibus 
eatur sedion ea suntisum

Ad milic toreptas esti 
sumquo corrum elibus-
dant aut eaque sequa 

pelen st, quoquae ipitorat 
fugias sersper ersperu 

mquibus eatur sedion ea 
suntisum

Ad milic toreptas esti sum-
quo corrum elibusdant aut 
eaque sequa pelen st, quo-
quae ipitorat fugias sersper 
ersperu mquibus eatur 

sedion ea suntisum

Ad milic toreptas 
esti sumquo cor-
rum elibusdant 

aut eaque sequa 
pelen st, quoquae 

ipitorat fugias 
sersper

Ad milic toreptas 
esti sumquo cor-
rum elibusdant 
aut eaque sequa 
pelen st, quoquae 
ipitorat fugias 
sersper

Ferorepu daescipsa 
nem quid eatate secero 
beriasp ellest autem 
sum exeroriam quaes 
venihitior re aborehent 
voluptia dolorep resci-
unt, ipsunt dolor

Ferorepu daescipsa 
nem quid eatate secero 

beriasp ellest autem 
sum exeroriam quaes 

venihitior re aborehent 
voluptia dolorep 

resciunt, ipsunt dolor

Ad milic toreptas esti 
sumquo corrum elibus-

dant aut eaque sequa 
pelen st, quoquae ipitorat 

fugias sersper ersperu 
mquibus eatur sedion ea 

suntisum

Ad milic toreptas esti sum-
quo corrum elibusdant aut 
eaque sequa pelen st, quo-
quae ipitorat fugias sersper 
ersperu mquibus eatur 

sedion ea suntisum

Mostly Just Look
There are nine options for Align and they are pretty self explana-
tory. A few details are in order though.

The Justifies
All four “Justify” options push the text on both the left and right all 
the way to the margins. The extra word in the name says only what 
happens to the last line.

For example, “Left Justify” means align all lines to both edges ex-
cept the last line which is aligned only to the left with some space  
after the last character.

Center Justify and Right Justify act accordingly.

Full Justify means even the last line should be forced to spread all 
the way from left to right. If there aren’t enough letters on the last 
line to fill it up, InDesign borrows from letters from the previous 
lines and adds extra space and does what it can. Usually the result 
is not very good looking. There will be some extra wide spaces be-
tween words somewhere.

The Spines
In a document with Facing Pages, Towards and Away From Spine 
behave like either Left or Right depending on which page they are 
on. I find it helpful for page numbers. If this document used Facing 
Pages, the page banner and footer would use the Spine orienta-
tions too.
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Package
asdf

Older Versions
asdf

Missing Data
zxvc

InDesign with InDesignPortability
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Place
Lorem ipsum dolor sit amet.

Layers
Object: Object Layer Options

Also works with Layer Comps if you are using them in Photoshop.

Transparency
hjk

Text Wrap
hjkl

Very FlexiblePhotoshop

Bis volut officiet quod qui ullo et exe repe qua rorerfe 
ratibea velit rem rep rep ernam volest, apicita cora tem 
porpo ribea solupici blaut volore pere, qui del ilisqui dolu 
pienis dolendi ctatus, se nis et et estio bearumOsapedio. 
Hillit aut im volupta tatio. Nam facerume voluptatum 
invellaccum latempossus eum quas am sust eicitionet, is

Bis volt offic et quod qui ullo et exe repe 
qua rorerfe ratibea velit rem rep rep 
ernam volest, apicita cora tem porpo 
ribea solupici blaut volore pere, qui del 
ilisqui dolu pi- enis dolendi ctatus, se 
nis et et estio bearumOsapedio.



58Gateway Software Workshop
InDesign

Place
Lorem ipsum dolor sit amet.

Layers
Object: Object Layer Options

Also works with Layer Comps if you are using them in Photoshop.

Transparency
hjk

Text Wrap
hjkl

Multi-Page
sdfv

Just PlaceIllustrator

Bis volut officiet quod qui ullo et exe repe qua rorerfe 
ratibea velit rem rep rep ernam volest, apicita cora tem 
porpo ribea solupici blaut volore pere, qui del ilisqui dolu 
pienis dolendi ctatus, se nis et et estio bearumOsapedio. 
Hillit aut im volupta tatio. Nam facerume voluptatum 
invellaccum latempossus eum quas am sust eicitionet, is

Bis volut officiet quod qui ullo et exe repe 
qua rorerfe ratibea velit rem rep rep er-
nam volest, apicita cora tem porpo ribea 
s o l u p i c i blaut volore pere, qui del 
ilisqui dolu pienis dolendi ctatus, se nis 
et et est io- bear um Osapedio. Hillit aut
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Vector is better
Lorem ipsum dolor sit amet.

Raster if  you have to
jkl

Print to PDFCAD

Bis volut officiet quod qui ullo et exe repe qua rorerfe 
ratibea velit rem rep rep ernam volest, apicita cora tem 
porpo ribea solupici blaut volore pere, qui del ilisqui dolu 
pienis dolendi ctatus, se nis et et est iobear um Osapedio. 
Hillit aut im volupta tatio. Nam facerume voluptatum 
invellaccum latempossus eum quas am sust eicitionet, is

Bis volut officiet quod qui 
ullo et exe repe q u a 
rorerfe ratibea v e l i t 
rem rep rep e r n a m 
volest, apicita cora tem 
p o r p o ribea solu
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Print - DIY
Lorem ipsum dolor sit amet.

Print - Professional
hjkl

Presentation
hjk

Electronic Distribution
hjk

hjk
hjk

Interaction with ConsumersOutput
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Header
Lorem ipsum dolor sit amet.
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Smooth...
Colors do not have to be solid. You can apply a Gradient to Strokes 
and Fills. You can make Swatches for Gradients. There is even a 
Gradient tool.

What?
A Gradient is a smooth blend between colors. Here on the left is a 
simple Gradient with only three colors. 

Gradients also have a type. They can be either Linear looking like 
a planar ramp, or radial looking like a bullseye.

How?
You can apply a gradient to an object by clicking and dragging on 
it with the Gradient tool. The Gradient is applied to either the 
Stroke or Fill depending on which square is currently forward, just 
the same as applying color.

Or you can select a Gradient Swatch the same way you would a 
color swatch. The Swatches panel menu has an option to create a 
new gradient swatch.

Change?
You edit a Gradient by double clicking on the Gradient tool or the 
swatch, or by opening the Gradient panel.

To add a color to a gradient just click on the space under the gradi-
ent. A new pot is made and you can move it.

To change a color in a Gradient select its pot and then change the 
color on the color panel or drag a color Swatch to the pot. Pots 
made from Swatches update if you edit the Swatch.

To remove a color from a Gradient, grab the pot and pull it away 
from the gradient.

GradientGradient

Linear Gradient fill.

Linear Gradient stroke

Linear Gradients at different angles.

Radial Gradient fill.

A Pot
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Hold Ctrl-ShiftGridded Placement

Imposing Order
Sometimes you know you want to bring in a group of pictures and 
arrange them in a regular grid. You can do this. It’s easy.

How?
Select the images in your thumbnailer and drag them to InDesign 
as usual. When InDesign shows you the loaded cursor, ready to 
drop the first image, hold down Ctrl-Shift. The cursor changes 
to a grid to let you know it’s going to work. Click and drag our a 
rectangle. You get a preview of the places the images will take. You 
can let go of Ctrl-Shift.

Adjusting
You can change the grid. Before you let go of the mouse

•	 Row Count - Up and Down arrows
•	 Column Count - Left and Right arrows
•	 Row Space - Shift Up and Down arrows
•	 Columns Space - Shift Left and Right arrows.

Fitting
After they are placed, all the images in the grid are selected. This is 
a great time to use your favorite fitting hotkeys if the images don’t 
all quite fit perfectly in their containers.
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PreparationTable of  Contents

3

Det ocastilis conscit 
diestra timmor publica; 
in se nequod ste, Catuspi 
onsulies! Sp. Sernihica in 
sidium publici piemurbem, 
ut feciosse ficions ulinterei 
practor talegeris, peri sce 
atruntu ex nos, orsum 
tum dem avo, consullare 
aricerricio, nondiciem 
tem inte ductare, o etiae 
detem tantusulicii publia 
cone prid ad senam opos, 
vilinerudem ego intella 
avolussolis.
Hucerit; C. et quem nius 
hos nox merfex nonsul hos 
pl. Castata beferissula v
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Site Analysis

1

Nam labor autent vel 
idunt milite con corrum 
res ditasi coruptatus acest 

ommolumquam vendant 
faccus exceriones et ilibus 
eatempore quis eatent 
acit isciis dolupti ature, 
cuptatur?
Nequam evendaepedi ant 
voluptat. Si ad et rerum 
faccum ut aut eum necti 
inci dolupta eatestions.

Study Models

4 6

Um sum sinvera sum sit 
voluptis volor auditibusdae 
liquatibus et volor ratem 
quas dolore sit et utem 
seque offici cuptatio. 
Adi optiberrum quae vel 
idiciur?

Proposal
Reptatibus, voloratempel id ese nitibus aperoritis cum 
soluptat vel magnime excerspides imus antur se aut 
etum laborepro que sitate list volendit prem facere 
qui ut vero dus.
Etur? Ne quis et od quo modione ne sima nam reheni 
con repudigenis molupta temped ulluptae ve.
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Concept

2

You Need to Do This First
InDesign has a pretty cool mechanism for creating a Table of Con-
tents (ToC). Just specify what kinds of things should be included, 
set some formatting and press the magic button. And if you go 
and change the document, you can update the ToC with the click 
of a button.

How Does It Know?
Table of Contents is based off of paragraph styles. You can see 
here in this little document to the left that there are section head-
ers, body copy, illustrations and page numbers. The ToC engine 
was told to take any text using the “Header” Paragraph Style and 
include it in the the ToC. It pulls all those entries together, figures 
out what page they are on and puts the text together.

Your Task
As you design and create your document think about how it will 
be divided, how you will mark the various sections. Use Paragraph 
Styles as you write so the ToC can pick them up.

Sneaky
You don’t have to use text that appears in the document. You can 
put text for the ToC on a non-printing layer and in its own special 
Paragraph Style. This is helpful if your design does not include 
obvious section headers or too many section headers. 

Or you could make two Paragraph Styles that look the same but 
only one of them gets picked up for the ToC. 

If you end up using one of these tricks it may be that your docu-
ment needs to be redesigned because the structure may not be as 
clear as it should. But then, sometimes, you just have to get the job 
done.
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How?
I always have to look for it. It’s on the Layout menu, down near the 
bottom. “Table of Contents...”. Click that and this dialog comes up. 
At first “Include Paragraph Styles” is empty. Select a style in “Other 
Styles” and click the “<<Add” button.

Try it now. Just hit OK and see that it works.

When you hit OK, InDesign loads the cursor with the text of the 
ToC. So click and drag out a Text Frame. InDesign fills it with the 
ToC. Cool, it worked.

Is That All?
Thankfully no, that is not all. Pull up the ToC dialog again. Add 
another Style or two. InDesign assumes that your document is 
organized hierarchically and each style you add is a sub-topic of 
the previous one.  If you want to change the levels that InDesign 
set up for you, select a style in the “Include” list and look for the 
spinner that says “Level”.

Formatting
InDesign defaults to using the Paragraph Style that generated a 
ToC entry for that entry. This frequently does not work well.

If you have chapters with giant 200 point text (see this document) 
on the chapter splash page, you probably want to use the chapter 
name but having 200 point text in your ToC would be a little much.

Solve this problem by specifying an Entry Style on this dialog. 
Maybe your Chapter Headers get drawn in ToC as Section Head-
ers and the Section Headers get drawn as Body. Whatever works.

But Really...
But really, I usually make brand new Paragraph Styles for the ToC. 
There are usually too many things I want to change to get the Para-
graph Rules and Tabs and Colors like I want. Each ToC style is 
named obviously, like “ToC-Section” and is “Based On” an existing 
Style just in case I change the look of the document the ToC can 
keep up.
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The Romans Are Coming!
The first spread in your document is probalby a single sheet and 
it is the front cover. Then inside there’s the title page. Then there’s 
the Table of Contents. And maybe an introduction. And a preface 
to the third edition... You can be twenty pieces of paper into a 
document before you even reach page 1. But InDesign thinks that 
is page 20. You need to be able to tell InDesign where page 1 is and 
what the other pages are.

It’s easy. You use Sections.

A Section is an arbitrary division in a document that you can place 
where ever you want. You only say where a Section starts. It does 
not end until the next one starts. Sections can have their own page 
number logic.

How?
On the Pages panel right click on the page you want to be the real 
page 1 and select “Numbering and Section Options.” You should 
get this dialog. Turn on “Start Section” and “Start Page Numbering 
at:”. Put in a ‘1’. Now this is page 1. Where it says “Style” you can 
specify what character sequence InDesign will use for displaying 
page numbers. You can use lower case Roman numerals, upper Ro-
man, upper or lower alphabet, or a variety of numeric options.

Clean Up
If the twentieth sheet is now page 1, what of the first 19 sheets?

The very first sheet might be the cover. It doesn’t count when num-
bering pages i - xviii, but InDesign won’t let you start numbering 
at 0. So the cover starts a section. The back of the cover sheet is in 
the same section. The first inside sheet starts another section with 
lower case roman (or whatever you like).
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Your New Best Friend
It starts off seemingly simple. Just select a few objects and push 
them over to the left of the page. But it is so much more than that. 
I could try to explain it, maybe show a few tricks, but I think you 
just need to get some practice in. Play with it. Touch all the buttons. 
Make mistakes when it doesn’t matter.

I’ll tell you a bit about how I use it, but I think this is one of those 
sections where another user might prefer a different set of tools.

•	 Align Objects - I use this group all the time. Align moves 
objects onto the same line. I align object tops to the top mar-
gin all the time. I also like to align a bunch of objects to either 
their common left edge or centers. 

•	 Distribute Objects - I don’t use this much. Distribute makes 
the distance from one thing to the next the same. If things 
aren’t the same size, this looks bad.

•	 Use Spacing (Distribute Objects) - set this if you know ex-
actly the spacing you want. “Place one object every inch.”

•	 Align to... - I use this all the time. On this page you see the 
CS4 version of the panel. By CS6 they changed the words to 
tiny pictures, but the meanings are the same. 
The two options I use the most are “Align to Margins” and 

“Align to Selection”. 
“To Margins” moves objects away from where they are and 
snugs them up against the margins. I love this for placing 
those pictures in the upper left corner. 
“To Selection” leaves the objects roughly in place and makes 
adjustments as needed. I love this for snugging captions under 
art, or making sure a column of art is on the same line.

•	 Distribute Spacing - I love this. It makes sure the spacing be-
tween objects is equal and looks pretty. See to the left on the 
second row how it made that look pretty? I use this instead of 
Distribute Objects.

•	 Use Spacing (Distribute Spacing) - if you know exactly how 
much space you want between objects and don’t care too muc 
exactly where the far edge lands.


